Each TechnoKids project consists of

Learn more about TechnoEntrepreneur

6 sessions, which are divided into
separate assignments. An
assignment is an activity that takes

Session 1

PL

Business Survey

E

about 20 minutes to complete.
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In this session, students become entrepreneurs. They organize the startup of their
business venture – to own and operate a restaurant. To begin, they are
introduced to spreadsheets and gain an understanding of how this tool is used
by 'real' professionals. They then survey their classmates to determine the type
of cuisine to serve at their restaurant. With this data, students tabulate and chart
the results using Microsoft Excel. This information is interpreted and summarized
in a report to potential investors in the following session.
Assignment 1: Introduction to Entrepreneur
Assignment 2: The Microsoft Excel Window
Assignment 3: Business Survey

Assignment 4: Business Survey Results
Session 1 Review: Spreadsheet Terms
Session 1 Skill Review: Name That Restaurant
Session 1 Extension Activity: Comparison of Chart Types

For the paperless classroom, each assignment,
review, skill review, and extension activity in
the TechnoKids Student Workbooks is also
included as a digital file.

TECHNOENTREPRENEUR

SESSION 1

Session 1: Business Survey
Getting session,
Started
For every
the Teacher Guide
Overview

features:
In this session, students become entrepreneurs. They organize the startup of their business venture
– to own and operate a restaurant. To begin, they are introduced to spreadsheets and gain an

 understanding
an introduction
with
materials
list They then survey their classmates to
of how this
tool is a
used
by 'real' professionals.
 preparation advice
 teaching strategies
Materials

 lesson
plans
for each assignment
 Microsoft
Excel


Flashcards (optional)



o

Excel Home tab

o

Excel Insert tab

o

Excel Chart Tools Design tab

Entrepreneur Folder
o

Entrepreneur template

o

My Survey sample file

Optional Activities
o

Session 1 Review: Spreadsheet Terms

o

Session 1 Skill Review: Name That Restaurant
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PL

 learning objectives for the session

E

determine the type of cuisine to serve at their restaurant. With this data, students tabulate and
chart the results using Microsoft Excel. This information is interpreted and summarized in a report to
potential investors in the following session.



Restaurant Name Survey sample

Teacher Preparation

(Refer to the Preparing to Teach section of this guide for instructions)



Make the Entrepreneur folder available to students.



Determine a location for students to save their work during this project.



(Optional) Print the flashcards listed in the materials list for this session.

Teaching Strategy

In this project, students become restaurant entrepreneurs. Explain scenario to students.
In this project, you are going to own and operate a restaurant. The first decision you
need to make is which cuisine, or type of food, you would like to feature at your
restaurant. The best way to do this is to survey a group of people to find out which cuisine
is most popular. If you serve the type of food which people really like, your restaurant will
make money and be successful.

TECHNOKIDS INC.
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In this session, students learn about the role of an entrepreneur. Discuss the following:
What is an entrepreneur? An entrepreneur is an individual who starts his or her own
business. Starting a business is a busy time in any entrepreneur's life. Critical steps can be
easily overlooked until the process is well underway. The number one criterion for success
is having a good plan. Starting and running a business is supposed to be fun. This is a
chance to be in charge and live a dream where time is spent doing something you are
really passionate about.

E

You will become an entrepreneur by owning and operating your own specialty
restaurant. This is a restaurant that specializes in a particular type of food, such as pizza,
hamburgers, tacos, donuts and so on. To begin your business venture you will conduct a
survey of your peers to learn about food preferences. The survey results help you to
determine the cuisine to server at your restaurant.
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Afterwards you will use a spreadsheet program to organize the information from your
survey. You will be able to change your results easily into a variety of graphs. These
graphs will show, in a very clear pictorial way, which type of restaurant is most popular.

Assignment 1 Introduction to TechnoEntrepreneur

In this assignment, students are introduced to the concept of entrepreneurs and spreadsheets.
The assignment helps students understand how useful a spreadsheet program is for a business
owner. Before you begin, introduce the following term(s):

This section for teachers explains each



Entrepreneur: a person who starts and runs his or her own business.



Spreadsheet: a computer program that organizes numerical information and can
perform mathematical functions.
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assignment and gives helpful tips.

Assignment 2 The Microsoft Excel Window

In this assignment, students learn the basic parts of a spreadsheet window, how to select cells,
and how to enter data. If your students are familiar with spreadsheets, you may use this
assignment as review, or simply omit it. Before you begin, introduce the following term(s):
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Worksheet: a sheet in a workbook, which contains cells, displayed in rows and columns.



Columns: vertical groups of cells in a worksheet. The shaded area at the top of each
column is called a column heading. Column headings are labeled alphabetically.



Rows: horizontal groups of cells in a worksheet.



Cells: a box where a row and column intersect is called a cell. Cells can hold words,
numbers, or mathematical formulas. Each cell has a cell reference, which is the unique
name or address assigned to that cell. A cell reference is based on its column and row
location in the worksheet. For example; the cell reference for the cell that intersects
column A and row 1 is A1.

TECHNOKIDS INC.
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Assignment 3 Business Survey
In this assignment, students prepare to start their restaurant business by conducting a class
survey. They poll their classmates in order to find out the most popular type of restaurant cuisine.
If you wish to view an example of a completed graph, look at the My Survey file in the Session 1
Sample File folder. You may also wish to show the sample file to the students for them to
understand what they are going to create. Before you begin, introduce the following term(s):


Survey: a method of collecting data in which people are asked to answer a number of
questions related to a specific topic.
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Assignment 4 Business Survey Results

E

Students ask their classmates which food they prefer to eat when dining at a restaurant.
Students may add a fifth type of restaurant cuisine in the "Other" box (subject to teacher
approval). Results are recorded by placing tally marks ( ) in the appropriate column for each
response received. Once each person in the class has been polled, students add up the results
and write the total for each cuisine type in the "Total" column.

In this assignment, students transfer the restaurant cuisine information from their handouts to a
Microsoft Excel spreadsheet. Before you begin, introduce the following term(s):


Graph: a picture created from a set of numbers. A graph shows patterns that are harder
to recognize by just looking at the numbers themselves. Some kinds of graphs are a line
graph, a bar graph, and a pie chart.
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You may find it useful to demonstrate how to make a chart to the class as a group. Illustrate how
to select multiple cells, or a data series, before clicking Insert Chart. In this way, the computer
knows which data is being used to generate the graph. Encourage the students to explore the
variety of possibilities of graphs discuss the uses and advantages of different types of graphs.
Discuss with the class which types of graphs would best fit which kind of numerical information.
For example:


Line graphs are best used to show changes over time.



Bar graphs are best used to compare sets of information to each other.



Circle graphs, or pie charts, are best used to compare the relationship of parts to a
whole.

Collect the printed copies of the worksheet from the students at the end of the session. You may
wish to start a file folder for each student that contains the printed material from
TechnoEntrepreneur. Students will also be printing a letter in Session 2, floor plan in Session 4, and
a spreadsheet in Session 5. It is important to keep the printouts because students will need to
refer to the information when they create a worksheet to calculate business earnings in Session 5
and a newsletter in Session 6.

TECHNOKIDS INC.
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Lesson Plan
Assignment 1 - Introduction to TechnoEntrepreneur


Read to learn about the concept 'entrepreneur'.



Find out how a spreadsheet program helps an entrepreneur.



Answer questions about spreadsheets.

Assignment 2 - Spreadsheet Basics
Open Excel.



Label the parts of the spreadsheet window.



Learn basic spreadsheet skills: working with columns, working with rows, working with
cells, entering data, and moving from cell to cell.



Close Excel.
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Assignment 3 - Business Survey

E



Survey classmates to determine the most popular restaurant cuisine.

Assignment 4 - Business Survey Results

Open the Entrepreneur template.



Enter the business survey results.



Create a pie chart by selecting the data series, inserting a pie chart, choosing the chart
layout, adding a title, and choosing a chart style.



Move and resize the graph.



Identify your work by typing your name.



Save the workbook as My Survey in an Entrepreneur folder.



Print the worksheet.



Close Microsoft Excel.
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The Lesson Plan lists the individual
steps in each assignment.
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Learning Objectives
Below is a list of the learning objectives for this session. Students should be able to complete
each task independently.
Content Knowledge:
 conduct a survey to find out about cuisine preference
 recognize the purpose of a spreadsheet program
 understand the purpose of a graph and the situations where it is useful
 understand the purpose of mathematics in the real world
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Operating Environment
 open and close a program
 open a template
 create a folder
 save a file to a folder
 print a file

E

Technical Skills:

Applied Technology
 organize survey data using spreadsheets
 graph data in a pie chart
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Spreadsheet
 select a cell using the mouse, enter key, tab key, and name box
 define the terms worksheet, workbook, column, column heading, row, row heading,
cell, cell reference, name box, and formula bar
 select columns or rows using the pointer, shift key, and ctrl key
 enter data into a cell by either typing it directly into the box or into the formula bar
 select the data series to be charted
 graph the results of a survey
 position the chart on a worksheet
 resize the chart
 select a chart layout and style
 type a title for the chart

Learning Objectives are specified for each
of the six sessions in the project.
A checklist of all objectives is provided at
the end of the project in Session 7.

TECHNOKIDS INC.
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Assignment 1: Introduction to TechnoEntrepreneur

You are beginning the project TechnoEntrepreneur.
An entrepreneur is someone who starts and runs his or her own
business. In your case, you are going to operate a restaurant.

E

Read to learn about how Microsoft Excel can help you organize your
business.

What is an Entrepreneur?
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An entrepreneur is a person who starts and runs his or her own business. The business may be a
store, restaurant, hair salon, or any other type of money making venture. An entrepreneur is
responsible for all aspects of starting up a company. They need to be able to plan their ideas,
raise money to begin the business, operate the company once it is open, calculate the financial
data, and continue to get others to invest in the idea. Although it is a lot of hard work and
financial risk, it is a rewarding job. There is no boss to tell the entrepreneur what to do, because
they work for themselves.

Students begin with an investigation of the

concept of Entrepreneurship. Some activities
can be completed prior to using computers.

How does a Spreadsheet Program Help an Entrepreneur?
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What are spreadsheets?
A spreadsheet is a grid made up of rows and columns that are used to record information. One
of the most common types of spreadsheet programs is Microsoft Excel. The great advantage of
using a spreadsheet on a computer instead of paper ledger is that it is much easier to add,
change, calculate, graph, and analyze data.
How does Microsoft Excel Help an Entrepreneur?
Excel lets an entrepreneur easily:


Record data: add information into the spreadsheet.



Calculate data: use formulas to quickly add, subtract, divide, multiply, count, average,
and do many other calculations.



Create graphs: graph the data to make pie, bar, line, and many other types of charts.



Make data look good: format the text, fill cells with color, or add borderlines to make the
information look attractive and easy to read.



Share information with others: information in a spreadsheet can be printed or copied into
other programs like Microsoft Word, making it easy to share information.



Store data: data is stored in workbooks that contain many worksheets.

TECHNOKIDS INC.
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Spreadsheets and You
1.

How do you use a spreadsheet program?

Questions help students build critical thinking skills.

What spreadsheet program(s) have you used in the past?

3.

Why do you think you will be a good entrepreneur?

SA
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2.
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Assignment 2: Spreadsheet Basics

E

In this assignment, you learn about the Microsoft
Excel window. Label the parts of the window below
using the descriptions on the next page.

Open Microsoft Excel

Students are introduced

 Open Microsoft Excel.
Click Blank workbook.

to the Excel window.

PL
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Label the Parts of the Microsoft Excel Window

Terms:
 Ribbon
 Formula Bar
 Group
 Title Bar
 Name Box
 Tab
 Sheet Tab
 Command
 File Tab
 Help
 Scroll Bars
 Cell

1.
2.

File Tab
Tab

5.
6.

Help
Name Box

9.
10.

Group
Command

3.
4.

Title Bar
Ribbon

7.
8.

Cell
Formula Bar

11.
12.

Sheet Tab
Scroll Bars

TECHNOKIDS INC.
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1-9

TECHNOENTREPRENEUR
Parts of the Microsoft Excel Window:
A bar at the top of the window that shows the name of the document, program name, and the
control buttons.

File Tab

Located at the left of the tabs on the ribbon, the File tab opens Backstage View. Backstage View
contains commands that affect the document as a whole, or the application itself. Commands
found include saving, opening and closing a document, as well as creating a new one, also
printing, and changing Excel options. To return to the document, click the Back button or press
ESCAPE.

Ribbon

A band along the top of the window that holds the quick access toolbar, title bar, tabs,
commands, window controls, and other tools.

Name Box

A box that shows the name of the active cell.

Tab

A part of the ribbon used to organize commands that do similar types of activities. For example,
the Insert tab has commands that add objects to the worksheet.

Help

A box at the top right corner of the window that gives help with the program. Answers are listed
when a question is entered into the box.

Cell

Found on a worksheet, a cell is a rectangular box that is identified by a unique letter and number
combination, for example A1. Type numbers or text into this box.
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Title Bar

Group

A collection of commands on a tab that do similar actions. For example, the Alignment group
contains commands that change the placement of text in a cell, such as Left, Center, or Right.

Scroll Bars

Bars used to change the part of the worksheet shown in the window. The worksheet can be
moved up or down using the vertical scroll bar, or to the left and right using the horizontal scroll
bar.

Sheet Tab

A tab at the bottom corner of the window that changes the active worksheet.

Formula Bar

A bar that lets you insert or edit the contents of a cell.

Command

A button, menu, or box that tells the program to do a task. A command often has a picture that
shows the action. For example, the Cut command looks like a pair of scissors.

1-10
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Learn Basic Spreadsheet Skills

An entrepreneur needs to know how to use a
spreadsheet program. Follow the instructions to
learn basic terminology and functions.

Illustrated, step by step instructions make

E

Working with Columns

learning spreadsheet skills fun and easy.
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Columns are vertical (up and down) groups of cells. The shaded area at the top of each column
is called a column heading. Column headings are labeled alphabetically. The worksheet only
shows a few columns, but Microsoft Excel has a total of 16,384 columns.

column heading

column

SA
M

 Click on column heading A.
 Click on column heading C.
 Click on column heading E.

1.

What happens when you click on the column headings?
The individual column is selected when the column heading is clicked.

 Now, click on column heading A, hold down the SHIFT key , and then click the column
heading D.

2.

What happens when you click on the column headings?
Columns A, B, C, and D are all selected.

 Click on column heading A, hold down the CTRL key , and then click the column C and E
headings.

3.

What happens when you click on the column headings?
Columns A, C, and E only are selected.

TECHNOKIDS INC.
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Working with Rows
Rows are horizontal (left to right) groups of cells. The shaded area to the left of each row is
called the row heading. Row headings are labeled numerically. The worksheet only shows a few
rows, but there are over a million rows in Microsoft Excel.

row

E

row heading

 Click on row heading 5.
 Click on row heading 10.
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 Click on row heading 15.
4.

What happens when you click on the row headings?

The individual row is selected when the row heading is clicked.

 Now, click on row heading 5, hold down the SHIFT key, and then click the row heading 10.
5.

What happens when you click on the row headings?
Rows 5, 6, 7, 8, 9, and 10 are all selected.
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 Click on row heading 1, hold down the CTRL key, and then click the row 5 and 10
headings.

6.

What happens when you click on the row headings?
Rows 1, 5, and 10 only are selected.

Working with Cells

A cell is the location where a row and column meet. Cells can hold words, numbers, or
mathematical formulas. Each cell has a name called a cell reference. The cell reference is
shown in the name box. A cell reference is the column and row location. For example, the cell
reference for the cell that intersects column A and row 1 is A1.
name box

selected cell

 With the mouse, click in cell A1 to select it.
 Move the mouse to column D, then count down 2 rows. Click to select the cell.

7.

Look in the name box. What is the cell reference?
D3

1-12
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How to Enter Text
 Select cell A1, type hello.
formula bar

cell
You can add text by typing in
the cell or in the formula bar.

 Press the SPACEBAR once and then type the word there.
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Move from Cell to Cell

E

 Click the mouse at the end of the word hello in the Formula bar.

 Press the ENTER key to move from cell A1 to cell A2.
 Press the TAB key to move from cell A2 to cell B2.
 Use the mouse to move to cell C3.
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 Highlight C3 in the Name box. Type B4, and then press enter to select cell B4.

8.

List the different ways you can move from cell to cell.
1) Click the cell directly with the mouse.
2) Use the ENTER key.
3) Use the TAB key.

4) Type the cell reference into the name box.

Close Excel

For the paperless classroom, students can answer

 Click the Close button.

the questions in their digital workbooks using the

 Do not save the changes.

latest version of Adobe Reader.
TECHNOKIDS INC.
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Excel and You
9. Have you used Microsoft Excel before? If yes, what did you use if for?

new knowledge about Microsoft Excel.

E

Students are challenged to reflect on their

PL

10. Microsoft Excel can be used to organize, graph, and calculate information. Identify a
career that would use Microsoft Excel.

SA
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11. How is Microsoft Excel similar to other programs you have used before?

12. In this project, you are going to plan a new restaurant. What skills do you have that will
make you good at designing, promoting, and running a business?

1-14
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Assignment 3: Business Survey

To organize the startup of your restaurant business venture, you must
survey your classmates to find out the type of food or "cuisine" they like
to eat when at a restaurant. The results of the survey will be put into a
spreadsheet using Microsoft Excel. The information will be used later to
create a report to try to raise money to start the company.

Cuisine

Italian

Tally (

= 5)

Total

SA
M

Steakhouse

PL

Conduct a Business Survey

E

To begin the survey, ask your classmates what food they like to eat
when dining out. Place a tally mark ( = 5) in the appropriate column
for each response received. Once each person in the class has been
polled, students add up the results and write the total for each cuisine
type in the "Total" column.

Mexican

Seafood

Other:

In TechnoEntrepreneur, students solve an authentic,
real world challenge – opening a restaurant. They start
by conducting a survey about food preferences.

TECHNOKIDS INC.
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Assignment 4: Business Survey Results

Open the Entrepreneur Template
 Open the Entrepreneur folder.

Enter Business Survey Results

PL

 Double click the entrepreneur file.

E

Now that you have discovered which type of food your classmates
prefer, you are going to put this information into a spreadsheet. In a
few easy steps you can create a clear picture, or graph, of the results.

 Select cell C5 on the Business Survey worksheet

SA
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 Using the information from the Business Survey assignment, type the total number of
people for Italian cuisine.

 Press ENTER.

 Continue adding survey results using the information from the Business Survey assignment.
 If you added a fifth cuisine, be sure to list it in the Type of Restaurant Cuisine column.

Using a template, survey results are entered
into a spreadsheet to create a graph.

TECHNOKIDS INC.
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Create a Pie Chart

A graph or chart is a picture or diagram that shows numerical
information in a clear, understandable way.

E

Use this activity to make a pie chart from the numbers and
words you entered in the spreadsheet.

Select the Data Series
 Click to select cell B5.

Cell B5 contains the
first bit of data.

PL

 Hold the mouse button down and drag to include cell C9.

Cell C9 contains
the last bit of data.
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Insert a Pie Chart

 Click the Insert tab.

Illustrated, step by step

 In the Charts group, click Insert Pie or Doughnut Chart.
 Select Pie, the first choice in the 2-D section.

instructions include tool
icons, sample window
views, and helpful tips.

A pie graph is a chart that divides a circle into parts.
The circle is like a "pie". Each piece of data is shown as
a slice of the pie where the whole pie is 100%. Each bit
of data is shown as a fraction of the whole pie.
The size of each piece depends on how many people
liked the cuisine type. The more people liking a food
type, the bigger the piece.

1-18

TECHNOKIDS INC.

TECHNOENTREPRENEUR
–

SESSION 1

A chart appears in the document. Chart Tools tabs are added to the ribbon. Chart Tools
include the Design and Format contextual tabs.

PL

E

A contextual tab is a set of
commands that are only
available when you are
completing a specific task

Choose the Chart Layout
Creating
a graph comparing food

 The Chart Tools Design tab should be active when the chart is selected. If not, click on

preferences
helps
the Design
tab. student

 In the Chartto
Layouts
group,what
click Quick Layout to expand the gallery of layouts.
entrepreneurs
decide

type of restaurant to start.
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 Rest the mouse over each of the layouts to display each layout name.
 Click to select Layout 6.

There are many layouts.
Layout 6 makes the graph
easy to understand.

Add a Title

 Click the chart title to select it.

 Triple click the mouse inside the box to select all the text.
 Type Restaurant Cuisine Preferences.

TECHNOKIDS INC.
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Choose a Chart Style
 Click the frame of the chart. In the Chart Styles group of the Chart Tools Design tab, click
the More arrow to expand the gallery.

More

E

 Click to select a style.
Making the chart clear is very important. The main purpose of the pie graph is to
inform people about the results of your survey. Here are some tips to make the
chart look great.

PL

Avoid a black background:
You are going to print this page. A solid black (or dark) background looks great
on the screen but uses a lot of printer ink.
Display the Chart Tools:
If you do not see the Chart Tools in the ribbon, click anywhere on the graph to
make them appear.

Move the Graph
 Click on the graph.
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 Hold the mouse over the graph border. Click and drag it below the survey data.

Resize the Graph

 Move the mouse pointer over the bottom right selection handle on the graph.

 Click and drag the corner handle to change the chart to the desired size.
o

drag inwards to make it smaller

o

drag outwards to make it larger

The mouse pointer changes
into a two headed arrow
over the sizing handle.
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SESSION 1

Identify
select
cells, columns, and rows
Your Work
 enter
data
into
cellsyour name.
 Select
cell A1
and type
 select a data series to be charted
Save a Workbook

 select a chart layout and style
 Click the File tab and choose Save As.

worksheet
 Go to the place where you save your work.
 Click
button
makes
a new folder.
 type
a the
title
forthatthe
chart
 Click Open.
 Name the file My Survey.
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 Click Save.
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 Label the folder Entrepreneur and press ENTER.

E

 position
and resize the chart on the
 Click Computer and then click Browse.

Print the Survey

 Click on a blank area of the worksheet.
 Click the File tab and choose Print.

Select Print
Active Sheets if
necessary.

TIP: If only the pie graph is visible
in the Print Preview window, it has
been selected. Click the Back
button and click on a blank area
of the worksheet.

 Click Print.
 Give the printed survey to your teacher.

TECHNOKIDS INC.

1-21

TECHNOENTREPRENEUR
You will be using this research information and the graph in the
next session.
Now that you know the type of food the majority of people
prefer, you will need to write a letter to borrow money for your
restaurant.

E

Including this spreadsheet information in your letter will make it
look professional and convincing.

Close Excel

Think About Pie Graphs

For which of the following tasks, would a pie graph be the best way to display the
data? More than one answer may be correct.
a)

Tracking the amount of money you make each week delivering newspapers

b)

Comparing the ways of getting to school: bus, car, bicycle, or walk

c)

Noting the daily temperature over a four week period of time

d)

Surveying kids' favorite after school activities

a)

Your teacher would like to find out what game is the class favorite for Physical
Education class. List the games you would use to survey your classmates.

b)

If you place the results into a spreadsheet and then make a pie graph, what
game do you predict would be the largest slice of pie?

c)

What game do you predict would be the smallest slice of pie?
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1.

PL

 Click Close.

2.

Students reflect on the purpose, value,
and application of spreadsheets.
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Session 1 Review: Spreadsheet Terms
Use the words from the list to answer the questions below.
 survey
graph
Review
lessons at the end
of
 header
column


cell



entrepreneur



worksheet



spreadsheet

sessions
to check
 row provide activities
 cell reference
and reinforce newly learned skills,

A computer program that organizes numerical information is called a…

concepts, and terminology.

spreadsheet
2.

A single page of a spreadsheet workbook is called a…

3.

A picture created from a set of numbers is a…
graph

4.

The box where a row and a column meet is called a…
cell

A method of collecting data in which people are asked to answer a number of
questions related to a specific topic is known as a…
survey
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5.
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worksheet

6.

E

1.

A vertical line of cells in a worksheet is known as a…
column

7.

A person who organizes and operates his or her own business is known as an…
entrepreneur

8.

A horizontal line of cells in a worksheet is known as a…
row

9.

The labels that signify the name of a row or column is called a…
header

10.

The alpha-numeric name given to a cell is called the…
cell reference

TECHNOKIDS INC.
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Session 1 Skill Review: Name That Restaurant

The name of your restaurant is very important. If the
name is popular, clear, and unforgettable for your
customers, your business has a greater chance of
being a success. Follow the directions to generate a
variety of names, survey their popularity, and graph
the results.

students to practice the

E

Skill Reviews are activities for
technical skills learned in the

1. Make up Names

previous session.
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Use your imagination and write down five possibilities for names for your new restaurant. Here
are a few guidelines:



the name should make it clear that the business is a restaurant



the name should indicate the type of food that you serve



the name should be catchy and something that a customer can easily remember

2. Survey Your Classmates
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Show the names of your restaurant to your classmates. Ask them to choose their favorite one.
Keep a tally list of the favorites. Ask as many classmates as you can for their opinions.

Name of Restaurant

Tally (

= 5)

3. Create a Spreadsheet
a.

Open Excel.

b.

Label one column Name and the next column Number.

c.

Write the possible names of your restaurant in the Name column.

TECHNOKIDS INC.

Click Blank workbook.
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Write the total number of tallies for each name in the second column.

e.

Adjust the width of the Name column by double clicking between the column
headings.

E

d.

PL

4. Make a Graph

Select the names and the totals:
Click to select the first name. Press and hold the SHIFT key and click to select the last
number.

b.

Click the Insert tab and choose Pie from the Charts group.

c.

Choose a chart layout style that includes a title, legend, and percentages.

d.

Type an appropriate title.

e.

Move and resize the graph to place it under the spreadsheet data.

f.

Add your name.

g.

Save the document as Restaurant Name Survey.

h.

Print your work to show which restaurant name was selected by the majority of people.

SA
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a.
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A sample of the Restaurant
Name Survey is available in the
Session 1 Skill Review folder.
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SESSION 1

Session 1 Extension Activity: Comparison of Chart Types

Spreadsheet information can be
displayed in a variety of graphs.
However, certain types of charts
show numerical information more
clearly than others. Compare
different chart types.

E

Extension Activities at the end of sessions
provide optional enrichment challenges.

Exploring Types of Charts

Open the file you created in Session 1 called My Survey.

b.

Click on the first worksheet tab at the bottom called Business Survey, if necessary.

c.

Select the 5 cuisines and totals and click the Insert tab to make a graph.

d.

Make a 2-D or 3-D column chart.

e.

Make a 2-D line chart to add to the column and pie charts.

f.

Select and delete the 'series' legend on the graphs.

SA
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a.

Questions
1.

Which type of graph do you think shows the restaurant cuisine most clearly? Why?

2.

Which type of graph do you think shows the favorite cuisine poorly? Why?

Save Your Work
a.

Click the File tab and choose Save as.

b.

Save this document as Comparing Graphs.

TECHNOKIDS INC.
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Which is the Best Fit?
Fill in the blanks with the best type of graph for the data. You may wish to have the My
Survey file open to make samples of the charts. Choose from the following types of
graphs.

Column
Line

Pie

PL

Area

A column graph is made of bars. Each bar is a piece of data. This type
of graph is used to compare values.
Data is represented in a line graph as points that are connected
together with a line. This type of graph is used to show how something
changes over time.
An area graph is points that are connected, with the space between
the points and x-axis filled with color. Each point is a piece of data. This
type of graph is used to show changes in values in distance or time.
A pie graph is a circle that is divided into slices. Each slice of pie is a
piece of data. This type of graph is used to show how one whole thing is
divided into smaller segments.

E

a.

You are planning how to spend your allowance. You have broken it down into
categories: long term savings, entertainment, clothing, food, and video games. You
are creating a graph comparing how much of your money is spent in each area.
Which type of graph would best show this data?

4.

You are working on a science assignment on weather. You are comparing the
average January temperature of 5 major cities in your country. Which type of graph
would best show this information?

SA
M

3.

5.

In another part of your science project, you would like to display the changes in
temperature in your home town each month over the period of a year. You use a
spreadsheet and choose which type of graph?

6.

You are planning a bike trip over hilly terrain. You would like to calculate and
graphically show the altitude changes. You research the altitudes at each checkpoint.
Which type of graph would you use to plot them?
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